
 

 

 

bMCA  
Basic Acquisition and 

Spectrometry Software 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

Version 1.7 

Release date: September 2013 



 2 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 3 

DISCLAIMERS 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Windows XP, Windows 7 and Windows 8 are registered trademarks of Microsoft Corporation. 

 

 

 

 



 4 

 

 

  



 5 

CONTENTS 

 

Disclaimers .............................................................................................................................................. 3 

Introduction ............................................................................................................................................. 7 

Installation ............................................................................................................................................... 9 

Software requirements ....................................................................................................................... 9 

Installing the application program ...................................................................................................... 9 

Installing the USB driver ...................................................................................................................... 9 

Basic Operations .................................................................................................................................... 13 

Connecting to a MCA ......................................................................................................................... 13 

Setting the acquisition parameters ................................................................................................... 14 

Data acquisition ................................................................................................................................. 18 

Spectrum visualization and manipulation ......................................................................................... 20 

Energy calibration .............................................................................................................................. 22 

Working with ROIs ............................................................................................................................. 25 

Peak search ........................................................................................................................................ 29 

Saving spectral data into files ............................................................................................................ 30 

Printing reports ................................................................................................................................. 30 

Nuclide libraries ................................................................................................................................. 31 

Working in MCS mode ....................................................................................................................... 33 

Using an external application for spectrum processing ........................................................................ 36 

Software elements ................................................................................................................................ 38 

Main menu ........................................................................................................................................ 38 

Toolbar .............................................................................................................................................. 40 

Status bar........................................................................................................................................... 40 

Preferences ........................................................................................................................................ 40 

Appendix A: Installation of bMCA drivers under Windows 8 ................................................................ 45 

References ............................................................................................................................................. 49 

 

 

 

 

 



 6 

 

 

 

  



 7 

INTRODUCTION 

This Manual describes the installation and operation of the software bMCA, which accompanies the bMCA 
compact multichannel analyzer (MCA).  

Using the bMCA software the user can perform the following functions: 

•  Control the operation of the bMCA device 

•  Set the different device parameters 

•  Perform data acquisition under Pulse Height Analysis (PHA) and Multi-Channel Scaling (MCS) modes.  

•  Visualize the energy spectrum 

•  Perform basic spectrum analysis operations like peak search, energy calibration, etc. 

•  Perform Region Of Interest (ROI)-based spectrum analysis  

•  Save acquired spectra to files in ASCII format 

•  Generate and print reports 

•  Create and use nuclide libraries  
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INSTALLATION 

This software is distributed together with the bMCA hardware. The distribution media can be of different 
types, e.g. CD-ROM, USB memory stick, etc. Additionally the program can be directly downloaded from our 
web site (http://www.brightspec.be). 

 

SOFTWARE REQUIREMENTS 

This software runs under Microsoft Windows XP, Windows 7 and Windows 8 1 operating system. 

There is no special software or hardware requirement other than having the necessary PC communication port 
available (USB or Ethernet) for connecting to the bMCA device. 

The bMCA software runs in either 32-bit or 64-bit Windows. 

 

INSTALLING THE APPLICATION PROGRAM 

The installation procedure is very simple, just execute the setup.exe program included in your distribution 
media and follow the instructions on the screen. 

  If you are updating the application, you will need to uninstall any previous version first. 

 

INSTALLING THE USB DRIVER  

Before using the USB version of the bMCA, the corresponding driver needs to be installed first. 

To install the USB driver under Windows XP: 

1. Connect the bMCA to the PC using the supplied USB cable. 

2. Windows will start the “Found New Hardware Wizard”, select the “Install from a list or specific 
location (Advanced)” option and click the “Next” button. 

3. When the next step window appears, select the option “Search for the best driver in these locations” 
and make sure that only the “Include this location in the search” box is checked. Then click the 
“Browse” button and use the directory navigator to go to the directory where the bMCA software was 
installed (usually “C:\Program Files\BrightSpec\bMCA”), select there the “USB Driver” folder and click 
“OK”. 

4. Windows will proceed to copy the USB driver. 

5. If the installation asks for the libusb0.dll proceed as before, but this time select the “x86” folder under 
the “USB Driver”. 

6. When the installation is complete, click “Finish” to close the Wizard. 

                                                                 
1 For special instructions on installing bMCA driver under Windows 8 see Appendix A of this document 

http://www.brightspec.be/
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To install the USB driver under Windows 7:  

1. Connect the bMCA to the PC using the supplied USB cable. 

2. Windows 7 is reluctant to load drivers for new hardware, so open the “Device Manager” 
(right-click on the “Computer” desktop icon, select “Properties” from the menu, then “Device 
Manager” from the “System” window). Look for a “BrightSpec USB device”, right-click on it 
and select “Update Driver Software…” from the menu. 

3. In the dialog that appears (Figure 1), click on the “Locate and Install driver software manually” link. 

 

Figure 1 - Windows 7 Update Driver dialog. 

4. Click on the “Browse” button and use the directory navigator to go to the directory where the bMCA 
software was installed (usually “C:\Program Files\BrightSpec\bMCA”), select the “USB Driver” folder 
and click “OK”. 

5. Make sure that the “Include subfolders” box is checked (Figure 2) and then click “Next”.  

 

Figure 2 - Selecting the USB driver folder. 
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6. Windows will proceed to copy the USB driver. 

7. When the installation is complete, click “Close” to close the dialog. 
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BASIC OPERATIONS 

The application software allows you to easily and quickly connect to the bMCA device and start acquiring data 
in PHA or MCS modes.  

CONNECTING TO A MCA 

The connection with the bMCA is very straightforward. After installing the application software and the 
corresponding drivers, simply plug the device into a free USB or Ethernet port, as per the device type.  

In the case of USB, wait until the OS plug-and-play system recognizes the device and the message telling that 
the hardware is ready to be used appears on your PC screen.  

Launch the bMCA program. To connect to a specific device, click on the “Connect” icon of the toolbar in the 
main window, or alternatively select “Connect…” from the “File” menu. The Device discovery window appears, 
as shown below:  

 

Figure 3 – Discovering devices. 

While the window is open, the application will keep searching for devices within the reach of the computer 
(USB and Ethernet) and, as they are located, their name will appear listed together with their corresponding 
location and serial number. USB devices are found quickly, while for Ethernet devices the operation can take a 
bit longer, depending on the local network load. 

You can now connect to a specific device by selecting its line on the list and clicking the “Open” button.  

  Please be aware that this basic version of bMCA software is able to open one MCA at a time. 

When the connection to the MCA is successfully established the status bar of the main window of the program 
will show a “Connected” message followed by the serial number of the device, as shown below. 

 

Figure 4 – Status bar of the main window showing a successful connection to a device. 

At any time you can also retrieve the device’s serial number, firmware version and other details by using the 
“Device Info…” option from the “Help” menu (Figure 5).  
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Figure 5 – Device information screen. 

After the connection to the bMCA has been established, the device is ready for data acquisition.  

SETTING THE ACQUISITION PARAMETERS 

The bMCA is an advanced, fully digital and microprocessor-based multichannel analyzer [1]. The device can be 
setup to process pulses from a wide range of scintillator detectors. The optimal performance for the different 
detectors under different experimental conditions can be achieved by setting the MCA parameters accordingly.  

All operational settings for the bMCA device are directly and easily accessible from this software.  

Once the connection to a particular device has been established, the “MCA” menu becomes available, as well 
as the related toolbar buttons in the main window.  

To change the MCA parameters, use the “Setup” option from the “MCA” menu. The “Settings” dialog will 
appear, showing the different settings conveniently grouped into several sections, as shown in Error! 
Reference source not found.. These sections are the following: 

1. Acquisition mode 

2. Preset time  

3. MCA 

4. Amplifier  

5. Filter  

6. High Voltage  

The MCA, Amplifier, Filter and High voltage settings are common for both PHA and MCS acquisition modes.  

Acquisition mode settings 
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Here the operation of the MCA can be switched between Pulse-Height Analysis (PHA) and Multi-Channel 
Scaling (MCS) modes. PHA mode is the most commonly used mode in traditional energy spectrum acquisition 
tasks. 

 

Figure 6 - “Settings” dialog, where the various MCA parameters can be easily set. Here the settings for PHA acquisition mode are shown 

By selecting PHA or MCS, the corresponding tab for Preset and MCA settings becomes available.   

Acquisition preset settings 

This section is used to specify the preset for the data acquisition. Several presets for data acquisition are built 
into the bMCA: 

1. Acquisition preset on time.  
2. Acquisition preset on counts. 
3. Acquisition preset on dual mode – time or counts. 
4. “Acquire forever” mode. 

Acquisition Preset on Time 

On this preset the device will acquire data until the time (in 
seconds) indicated in the corresponding field is reached. The 
drop-down box next to it allows the user to choose between Live 
Time (LT) and Real Time (RT) measurements. 

Acquisition Preset on Counts 

On this preset the device will acquire data until the amount of 
counts indicated in the corresponding field is reached. This count 
recording can be specified within a region in the MCA. The limits 
of the region are specified with the “Lower channel” and “Upper channel”, see Figure 7. In other words, under 

Figure 7 – Acquisition preset settings section 
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this preset mode the data acquisition will be stopped when the number of counts between “Lower channel” 
and “Upper channel” (inclusive) reaches the value specified in “Counts”.   

  The limits of the region can be quickly and easily set using the button “Use ROI”. Selecting this 
button will toggle between the ROIs already marked in the spectrum plot.  

Dual Mode Preset – Time or Counts 

On this preset the device will acquire data until the first of the two presets conditions (Time or Counts) is 
reached. Each preset condition works as explained before.  

The dual data acquisition preset is activated when both check boxes (Time and Counts) are selected.  

Special Preset – “Acquire forever” 

When none of above particular presets is selected the MCA is set to acquire indefinitely. In this case the data 
acquisition will only stop when a manual “Stop” command is issued.  

The “acquisition forever” preset is selected when none of Preset check boxes (Time or Counts) is checked.  

Before starting the indefinitely counting mode a message will be shown for confirmation.  

  Please notice that not all bMCA devices support all above-mentioned acquisition preset modes. 
For those cases the Settings dialog will disable the controls corresponding to the unsupported 
functionalities as shown in the screen shot below. 

 

Figure 8 –Settings dialog showing a possible settings when connected to an earlier version of bMCA were extended acquisition preset 
modes were not supported. 
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MCA settings  

Here the parameters for the multichannel analyzer can be set.  

“Channels” sets the active number of MCA channels to be used for acquisition. The possible values are 256, 
512, 1024, 2048 and 4096 channels. 

“LLD” sets the level of the Lower Level Discriminator (LLD). The value is in channels. 

Likewise, “ULD” sets the value for the Upper Level Discriminator (ULD). The value is in channels. 

Amplifier settings 

“Coarse gain” sets the amplification level of the main analog stage. Selection is from x1 up to x128 in powers of 
two. 

“Fine gain” allows fine-tuning of the amplification level. The value is a fractional number from 1 to 2 and is set 
by the sliding bar control.  

“Digital gain” sets the DSP gain. Choices are from x1, x2… up to x1024 in power of two. The value specified for 
the Digital Gain depends on the number of channels used, and should be higher or equal than 32 for 1024 
channels (64 for 2048, and so on) or truncation of the spectrum may occur. 

“Input polarity” sets the polarity of the input signal. User can select between negative and positive polarities. 
The polarity of the electronic signal applied to the MCA can be easily inspected by using the digital oscilloscope 
implemented in this software. Note that for PMT tube-based MCAs like the bMCA the polarity has to be set 
always to negative. 

Filter settings 

The operational parameters of the digital shaper in the MCA can be changed here.  

“Threshold” sets the input noise level threshold of the shaper and is typically used to cut off the electronic 
noise of internal and externally origin that appears on the lower channels of the spectrum. 

“Rise time”, as the name says, specifies the rise time of the digital trapezoidal pulse. Value is in µsec. 

“Flat top” sets the duration of the flat top component of the digital trapezoid pulse. Value is in µsec. 

“Poles/zeros” sets the value for poles and zero cancellation [1]. 

“Digital BLR” is used to enable the use of the Digital Base Line Restorer (BLR). 

“Pile-up reject” enables the use of pile-up rejector in the MCA. 

High Voltage  

Here you can set the operational voltage for the scintillation detector2. The input value is in Volts (0 to 1500). 

With the check box you can turn the High Voltage ON and OFF. 

  Please be aware that any changes to the settings will not be sent to the device until you press 
the “Apply” button. 

                                                                 
2 Please check the detector’s manufacturer specifications for the operational high voltage of your detector.  
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You can change the MCA settings while the acquisition is taking place, so you have a quick feedback of the 
device’s performance.  

  It is also important to mention that the MCA settings can be stored into the device’s permanent 
memory and will remain there even after powering off the MCA or disconnecting it from the PC.  

In MCS mode the settings are similar as those described above, except for the Preset time, where the input 
represents the Dwell time for each channel of the MCS spectrum.  

For MCS operation, the user can set conveniently the values of the Single-Channel Analyzer (SCA) window by 
changing the LLD and ULD values. These values are in channels. 

The bMCA software includes an advanced method to set the SCA window. By clicking the “Setup” button, a 
dialog will appear where the user can specify the SCA window boundaries from stored ROI values, or even 
directly from a list of nuclides defined in a nuclide library. For more details on this, see the corresponding topic 
further in this manual. 

Finally, the “Store” button is used to save all the operational parameters in the non-volatile memory of the 
bMCA device. 

 

Figure 9 - Settings for the MCS acquisition mode. 

 

DATA ACQUISITION 

The acquisition of the energy spectrum can be started as soon as the connection to the MCA is made. But 
before starting it, the required operational settings should be set as described in the previous chapter. 
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However, if the settings have been already fine-tuned in a previous session, the acquisition of the spectrum can 
be started right away. 

To begin with the acquisition, ensure that the preset time has been set to the desired value, and then click on 
the “Start” button of the main toolbar or select “Start” from the “MCA” menu. You will notice that the related 
toolbar buttons and menu items become enabled or disabled according to the acquisition status (i.e., the 
“Start” button gets disabled while “Stop” becomes enabled).  

As the data acquisition takes place, the spectrum (counted events distributed by their energy) is visualized in 
the main area of the application window, as shown below. 

 

Figure 10 – Main window of the bMCA software while a spectrum is being acquired. 

During acquisition, the different status bar panels will show the following information: 

First (leftmost) panel Connection status 

Second panel Acquisition status: Acquiring, Stopped, Paused 

Third panel Current acquisition mode: PHA or MCS 

Fourth panel Current acquisition preset and preset value 

Fifth panel 
Elapsed time in seconds. An asterisk indicates the current preset time (Live Time or 
Real Time), when the device is on “Time” acquisition preset. In parenthesis the dead 
time is shown as percent of the elapsed time. 

When the data acquisition reaches the specified preset value it automatically stops, and the corresponding 
menu commands, toolbar icons and status bar information get updated. 
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The data acquisition can be stopped at any time before the preset time is reached by pressing the “Stop” 
button in the tool bar or by selecting “Stop” from the “MCA” menu. 

The data can be cleared up without stopping the data acquisition. Clicking the “Clear” button or selecting 
“Clear” from the “MCA” menu will cause both the accumulated spectrum and the elapsed time to be cleared 
without needing to stop the acquisition.  

The bMCA software provides many commands and information to customize the display and to manipulate the 
spectrum during and after acquisition.  

 

SPECTRUM VISUALIZATION AND MANIPULATION  

During acquisition, the bMCA application software provides several commands and tools to display and analyze 
the data being acquired. The figure below shows the main window with its different areas:  

 

 

Figure 11 - Main application window 

Most of the actions are executed from the application’s main menu. There are commands to read and write 
spectral data files, to control MCA operation, to change display parameters, to perform calibration and to 
manage nuclide libraries. A quick guide of menu items commands is given in the “Software elements” chapter 
of this manual. 

Main menu commands Main toolbar operations 

Spectrum cursor information panels 

Spectrum area ROI information panel Status panel 
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The toolbar has buttons for the most often used commands. That way, the associated actions can be quickly 
executed by just a click of the mouse. The toolbar is also aware of the status of the connection and acquisition, 
meaning that the different buttons become enabled only if the corresponding functionality is allowed under 
the current operational status.  

The spectrum plot, or graph, is displayed in the center of the main window and shows the channel distribution 
(usually corresponding to energy values) of the counted detector events. In the case of PHA acquisition the 
spectrum is distributed by the energy of the detected photon (event), while in the case of MCS the events are 
distributed by time (Dwell) and the intensity corresponds to those events counted in the defined SCA energy 
window. 

The color scheme and layout of the spectrum plot can be changed according to user’s preferences (more 
details are given further in the “Preferences” chapter). The Y-axis shows the intensity of the counted events, 
while the X-axis shows the channel number or corresponding energy. The switch between channels and energy 
scale can be quickly made by using the context menu or by selecting “Channels” or “Energy” from the “View” 
menu. 

To correctly establish the relationship between channels and their corresponding detected photon energy, the 
user should calibrate the spectrometer (i.e., detector + MCA). This process is commonly known as “spectrum 
energy calibration”.  

If no calibration has been taken place, a default set of calibration values will be used, consisting of a linear 
curve with a slope of 2 keV/channel and a 0 keV offset. However, to remind the user of this condition, the 
second panel of the cursor information will show the message “Not calibrated” (as seen in 
Figure 10, for example). This message is cleared only after a valid energy calibration is 
performed.  

The Y-axis of the spectrum graph can be set to display a linear, square-root or logarithmic 
scale; thus making the spectrum intensity visualization quite refined. These commands are 
available from either the “View” menu, the graph context menu and from the toolbar.  

Additional spectrum-related commands are also accessible via the context menu which 
appears by right-clicking on the spectrum plot.  

The spectrum plot includes a cursor, which is the vertical dashed line that runs from top to 
bottom of the graph area. The cursor can be moved by dragging the mouse pointer, or by 
using the keyboard arrow keys ( and ). As the cursor moves over the spectrum, the 
information panels located at the top of the plot area update their contents. The panels 
display the following information: 

First panel (leftmost) Channel number corresponding to the cursor position in the spectrum. 

Second panel Corresponding energy value, in keV, if energy calibration has been performed. If 
no energy calibration is stored, the message “Not calibrated” will be shown. 

Third panel Number of counts at current cursor channel. 

Fourth panel Current spectrum throughput, shown in counts per second (cps) 

Figure 12 – Context 
menu bar of the 
spectrum plot. 
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A zoom function is implemented in the application (Figure 13) that allows the user to inspect details of a 
portion of the spectrum. When the zooming is on, the display plot becomes divided in two areas: the bottom 
one with the full spectrum and the upper one containing the zoomed portion. The zoomed area is represented 
in the full spectrum by a red box that can be moved and resized freely using the mouse. To move the box, click 
inside it and drag the mouse; to resize it, click and drag the borders.  

 

Figure 13 – Spectrum view in zoom mode. 

The zoom functionality can be invoked via “Zoom In” from the “View” menu, or by using the corresponding 
toolbar button. The last is a toggle, i.e. it stays pressed while zoom view is active. To return to the full spectrum 
view, select “Zoom Out” from the “View” menu or click the “Zoom” button of the toolbar again. 

The spectrum plot also supports visualization of Regions Of Interest (ROIs). To mark a region of the spectrum, 
position the cursor on the start channel and then drag the mouse while holding down the SHIFT key until the 
end of the region is reached. This also works the other way around, i.e. dragging from the end channel down to 
the start of the region. The color scheme use for marking the ROIs depends of the options chosen in the 
“Preferences” dialog. 

When moving the spectrum cursor over an existing ROI, the software will automatically recognize it and 
displays the associated computation results (ROI analysis) in the ROI information panel located to the right of 
the spectrum display.  

ENERGY CALIBRATION  

As explained before, a very important and necessary step in any nuclear spectrometer is to establish the 
relationship between MCA channels and the energy deposited by the detected photon or counted event. This 
operation is called spectrum energy calibration. Once this step is made, the spectrum can be viewed and, what 
is most important, analyzed in energy units.  

The bMCA software provides several ways to perform the energy calibration quickly, easily and efficiently.  
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The simplest, straightforward method is invoked by selecting “Calibrate” from the “Edit” menu, or by selecting 
“Calibrate” from the spectrum plot context menu. The calibration dialog is shown below. 

 

Figure 14 – Energy calibration dialog. 

Moving the spectrum cursor to the position to be used in the calibration procedure (usually the centroid of a 
peak) causes the “Channel” field to be automatically updated with the current cursor channel position.  

In the field “Energy” the energy of the corresponding peak must now be entered, in keV. Alternatively, a 
pull-down list containing the energy lines defined in the user-defined nuclide library can be invoked. In this case 
the energy value is automatically taken from the emission chosen from the nuclide list.  

Once at least one point is entered, the energy relationship will be calculated. The results are shown as the 
calibration coefficients “Offset”, “Slope” and “Quadratic”. 

  Please notice that in this early version of the bMCA application a quadratic function is used as 
the mathematical model for the energy calibration (which is perfectly adequate for most 
scintillation-detector applications). Therefore, up to three points can be used for the 
calculation. In future versions of the software more sophisticated mathematical models will be 
implemented.  

Once an energy calibration is established, the X-axis of the spectrum plot can be changed to display energy 
units (keV) instead of channels. In addition, all the ROI analysis results will be correctly displayed in energy 
units.  

If no energy calibration is performed, the software will use a set of default values (Quadratic = 0 keV/ch2, 
Slope = 2.0 keV/ch, Offset = 0 keV). 

Another way to perform the energy calibration is via the “Peak Search” function. To start the peak search 
engine, select “Peak Search” from the “Tools” menu. 

When the dialog appears (Figure 15), click on the “Peak search” button. The peak search parameters can be 
adjusted if necessary (see further details in the “Peak Search” chapter). After the spectrum peak search 
finishes, the peaks found are listed showing their channel location, and become available for selection. Clicking 
on an entry causes the spectrum cursor to move to that peak position in the spectrum; that way it is possible to 
verify that the correct or desired peak is used for energy calibration.  
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Figure 15 – Peak search dialog. 

Now select up to three peaks (since the program uses a quadratic calibration) and check their corresponding 
checkboxes. Then enter the corresponding energy by right-clicking on the peak line; a menu will appear with all 
the energy peaks currently defined in your nuclide library, as shown below:  

 

Figure 16 – Performing energy calibration via peak search. 

Select the correct one. Perform the step again for the other selected peaks and then click on the “Calibrate” 
button to make the calculations. If successful, the computed coefficients (Quadratic, Slope and Offset) will be 
shown for approval, as shown in the next figure.  
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Figure 17 – Energy calibration results via peak search method. 

If the calibration is confirmed, the program will then ask you to apply the new calibration to the current 
spectrum. An affirmative answer will complete the energy calibration procedure via Peak Search. 

 

Figure 18 – Confirmation dialog for new energy calibration. 

WORKING WITH ROIS 

A Region Of Interest (ROI) is a portion of the energy spectrum that represents a particular interest for the 
spectroscopist. This might be because of a certain radiation emission is expected to be uniquely detected by 
recording signals in that particular energy region, and is of great interest for the spectrum analysis or decision-
making process.  

Plain ROI spectrum analysis, although simple, might be very powerful and provides enough evidence for 
decision-taking or spectrometry analysis conclusions.  

The bMCA software offers a wide range of ROI spectrum analysis.  

The first step in any ROI spectrum analysis is to correctly define the energy 
region of the spectrum to be analyzed, or simply to define the ROIs. ROIs 
can be quickly set at any time, whether the data acquisition is taking place 
or not. The interactive definition of an ROI is done by dragging the 
spectrum cursor using the mouse over the region of the interest in the 
spectrum while pressing the SHIFT key. As pointed before, this selection 
can be done from left-to-right (start channel to end channel of ROI, or low 
energy to high energy) or vice versa, from right-to-left. The color scheme 
used to mark a given ROI is taken from the “Preferences” set by the user. 
Each ROI has an identification string or label associated with it. When an 
ROI is entered interactively as described above, its label ID is automatically 
set according to a default notation of “ROI number”, e.g. ROI 1, ROI 6, etc. 

As soon as a portion of the spectrum is marked as ROI, the ROI analysis is 
performed and the corresponding calculations are completed. If an ROI is 
marked while data acquisition is active, the ROI analysis results get 

Figure 19 – ROI information panel. 
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updated on a regular basis as well as at the end of the preset acquisition time. 

When the spectrum cursor is placed over an ROI the software automatically recognizes it and displays the 
current ROI analysis results in the ROI information panel (see Figure 19) located to the right of the data plot 
area. 

In this panel the following ROI parameters are shown:  

ROI ID The ROI identification string, shown in the same color as the ROI in the 
spectrum. 

ROI left (chn) ROI left channel limit. 

ROI left (keV) Corresponding ROI left limit in energy units (keV). 

ROI right (chn) ROI right channel limit. 

ROI right (keV) Corresponding ROI right limit in energy units (keV). 

Integral Total counts recorded in the ROI. The corresponding count rate is also 
given in parenthesis. 

Net area Net area (integral counts corrected for the continuum) of ROI, in counts. 
The corresponding count rate is displayed in parenthesis next to it. 

Continuum Base peak counts in the ROI, also known as background counts. Count 
rate also shown in parenthesis. 

ROIs can be edited after they have been defined. To invoke the ROI editor, place the spectrum cursor over any 
part of the ROI and right-click to bring up the context menu. In this case, the currently selected ROI will be 
shown in the ROI editor dialog.  

Using the ROI editor you can change the ROI ID, its boundaries (in channels) as well as its color.  

 

Figure 20 – ROI editor dialog. 

Clicking the button next to the color label will bring the OS color dialog box for choosing a new color for this 
ROI. The color of this button reflects the current color assigned to the ROI.  
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The “Visible” checkbox controls whether the ROI is displayed or not in the spectrum. 

This dialog also shows a larger number of ROI computation results. They are described in the table below: 

ROI ID Identification string or label for this ROI. 

Integral Total (sum) number of counts in the ROI. 

Total background Total number of counts in the continuum of the ROI. 

Background per channel Number of counts per channel in the continuum of the ROI. 

NET Area Corrected (for the continuum) the number of counts in the ROI. 

Centroid Center of mass for the ROI, given in channel number. 

Centroid in energy Center of mass for the ROI in energy units (keV). 

Estimated NET intensity Calculated intensity of the ROI corrected for the contribution of the 
continuum. Given in counts. 

Maximum counts in 
channels The maximum counts found in a channel of the ROI. 

FWHM in channels Full width at half maximum (FWHM). Value given in channels. 

FWHM in energy Full width at half maximum (FWHM). Value given in energy (keV). 

FWHM in percentage Full width at half maximum (FWHM). Value given as percent relative to 
the centroid. 

The interactive ROI marking is the simplest and faster way of entering ROIs and 
performing ROI analysis. Yet the bMCA program permits additional ways to set 
and analyze regions in the spectrum. These extra methods can be found under the 
“ROI” submenu of the “Edit” menu (Figure 21). 

The “Add” option brings up the manual ROI definition dialog. Using this form you 
can set precisely the ROIs boundaries, ID and color. The advantage of setting the 
ROIs using this method is that you can accurately define the ROI limits, rather than 
relay on mouse or spectrum cursor operations.  

 

Figure 22 – Adding ROI using the manual method. 

Figure 21 – ROI menu items. 
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A powerful method to define ROIs is by using nuclide emission data. The bMCA application incorporates this 
method as shown below: 

 

Figure 23 – Creating ROIs from nuclide emissions library file. 

By clicking on the “Open library” button you can load the nuclide emissions that were previously stored into a 
nuclide library file. The radiation emissions are then listed in this dialog for your choice.  

An effective way of visualizing the emission boundaries directly in the current spectrum is built-in into the 
application. Using the “Preview” check box causes the energy emissions that are currently selected (with a 
check mark) to be shown in the current spectrum. The FWHM factor can be varied in order to make the 
expected ROI from those emissions wider or narrower, to compensate for different types of scintillator 
detectors. The ROI width is set as Factor x FWHM, where FWHM is the expected theoretical FWHM and Factor 
is the coefficient entered in the corresponding field. The following figure illustrates how this useful ROI addition 
process works. 

 

Figure 24 – Adding ROIs from a nuclide library. The emissions corresponding to nuclides Cs137 and Am241 are selected and the 
“Preview” option chosen with 2 x FWHMs. The expected ROIs are shown in grey color on the existing energy spectrum. The previewed 
ROIs are properly labeled as well. 
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Clicking the “Add ROIs” button will add the selected ROIs to the current spectrum. An automatic ROI label will 
be generated using the radionuclide name and the type of emission; e.g. “Cs137 X-ray KA1”. 

Another quick and efficient way to set ROIs is by saving them into a file and reloading then at a later stage. 

The bMCA software allows you to load ROIs that have been previously saved into a file (*.ROI). This can be 
done by selecting “Load from file…” from the “Edit/ROI” menu. The figure below illustrates this process.  

 

Figure 25 – Importing ROI definitions from stored files. 

Using this form you can open any file that contains saved ROIs definitions. The dialog will list all the ROIs for 
you to select. As with the dialogs previously seen, you can preview the ROIs by showing them in the current 
spectrum. You can also decide whether to set the ROIs by using their channel boundaries or by their energy 
limits. By checking their associated check box and clicking “Add ROIs”, the selected ROIs will be added to the 
current spectrum and the corresponding computations performed. 

Any set of ROIs can be saved into a ROI file (*.ROI) at any time. This is done by selecting “Save to file…” from 
the “Edit/ROI” menu. ROI files are ASCII text files and contain all the ROI definition parameters. They can be 
recalled at any time to re-establish those ROIs. 

Finally, any ROI in the energy spectrum can be deleted. The menu item “Edit/ROIs/Delete All” will erase all ROIs 
definitions from the current spectrum.  

To delete a single ROI place the spectrum cursor inside the ROI boundaries and left-click with the mouse while 
holding down the CTRL key.  

PEAK SEARCH 

The bMCA software provides a few spectrum analysis tools. One of them is a basic peak search in the energy 
spectrum.  

To perform this analysis select “Peak search” from the “Tools” menu. With the dialog that appears (Figure 15) 
you can search for peaks in the spectrum using different parameters. The sensitivity and accuracy of the peak 
search is affected by the values of “Threshold” and “Filter”. The values presented are the default ones for a 
typical spectrum acquired with a NaI(Tl) scintillator detector of 2x2 inches and relatively good counting 
statistics. If desired, you can change these parameters to fine tune your peak search routine.  

The peaks found will be displayed on the list of this form. By selecting any item (peak search result) the 
spectrum cursor will move to that position, so you can quickly check the accuracy of the results of the search or 
chose the peaks that you are interested in.  
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The peak search method can be used in combination with the “Energy calibration” procedure. More details 
about this were described in the Chapter “Energy Calibration” earlier in this Manual.  

SAVING SPECTRAL DATA INTO FILES  

Every acquired spectrum can be saved into a file. Spectral files can be later reloaded for further inspection 
and/or analysis.  

The bMCA software uses two types of spectrum file formats: 

• Block-structured ASCII text files that include many parameters (e.g. all acquisition settings, energy 
calibration, etc.) that can be conveniently recalled at later stage. By default, these files are saved with 
a “.spe” file extension. The format is compatible with the IAEA SPE specification, and is used also by 
well-known programs such as AXIL and ORTEC Maestro.  

• Plain ASCII text files that simply contain the spectral data information, one channel per line. By default 
these files are saved with a “.dat” extension. 

Clicking on the “Save” button of the toolbar will cause the software to save the full spectrum file (SPE format). 
A standard file selection dialog will be displayed to allow the user to give the file a suitable name. This is the 
same as using “Save all…” from the “File” menu. 

To save just the spectral data select “Save spectrum only…” from the “File” menu.  

To open a spectrum, use “File/Open…” or click on the “Open” toolbar button. Just make sure no acquisition is 
active or that the application has disconnected from the bMCA, as any active measurement will overwrite the 
loaded spectrum with the current one from the bMCA. 

PRINTING REPORTS 

Reports can be generated using the bMCA software capabilities. The reports are fully graphical and in colors. 
They contain different sections, which can be selectively turned on and off in the “Preferences” dialog. 

Reports are produced by selecting the “Print…” from the “File” menu. An example of a report is shown below:  
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Figure 26 – Typical spectrum report, showing a portion with the ROI analysis table results and the color spectrum plot. 

The report window can be conveniently resized for best view, and the contents of the report are automatically 
adjusted to the size of the window. Each report can be printed as well.  

NUCLIDE LIBRARIES 

The bMCA application has powerful nuclear libraries capabilities, easy to use and very comprehensive. First of 
all, the bMCA installation includes a full nuclide library with ALL recognized nuclear decay emissions [2]. The 
software also provides the necessary tools to create or edit your own nuclear libraries to match your 
spectrometer specifications or specific measurements or applications conditions. 

The bMCA software implements a very complete and advanced Nuclide Library Editor. Using this editor you can 
create your own nuclear data libraries. A nuclide library contains the necessary data for each radioactive 
emission that can be used or linked to the peaks recorded in the energy spectrum, thus making possible its full 
analysis. 

A screenshot of the nuclide library editor is shown below:  
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Figure 27 – Nuclide library editor. 

To search for specific radionuclide emissions follow these steps: 

• Select an element from the pull-down list labeled “Element”. In this list, all known elements will be 
listed for your selection. The elements are displayed using their standard chemical symbol, e.g. Cd for 
Cadmium, H for Hydrogen, etc.  

• Once a particular element has been selected, the list box below it will show all the Isotopes known to 
that element. The Isotopes will be listed as Chemical symbol – Mass Number3. That is, Cd-109 for 
Cadmium Isotope of 109 Mass number. 

• Select the isotope of interest from the list and the type of radiation, gamma or X-rays4.  
• The search can be further narrowed by setting the minimum level of the intensity of the decay 

emission. That is, the software will search photon radiation emission for that particular radioisotope 
with intensity equal or above the one specified in the “Minimum intensity” field. The value in this field 
must be in percent. 

• Click on the “Show” button.  

The records found that correspond to the query will be listed in the grid for that purpose with the following 
information: 

• Sequential number of the record. 
• Half-life of the level of the radioisotope emitting this radiation. 
• The energy of the emitted photon radiation (in keV). 
• Its relative intensity in percent. 
• An identification string for the type of radiation (e.g. G for gammas, X-ray KA for X-ray emissions from 

the Kα shell, etc.).  

You can select the desired emissions by checking the associated checkbox, and then use the “Add” button to 
add them to the list of emissions to be saved into a nuclide library.  

                                                                 
3 The total number of protons plus number of neutrons in its nucleus represents the mass number of an 
isotope. 
4 Since this is a photon-spectrometry software, only photon-type decay emissions are applicable. 
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The above process can be repeated for all the radioisotopes of your interest, creating in such a way a list of 
radiation emissions that will be part of the nuclide library. On the right side of the dialog the records of the 
different candidate emissions will be listed. This list is the one to be used when creating the nuclide library file.  

Emissions in this list still can be deleted and/or edited, and a toolbar button has been provided for that 
purpose. To edit a nuclide emission, select its record in the list and click the “Edit” toolbar button. In this case, 
the “Nuclide Emission Editor” will be shown, where all the fields related to this emission that can be edited, as 
shown in the screenshot below. 

 

Figure 28 – Nuclide radiation emission editor. 

Please notice that each radiation can be grouped into a category. The nuclide categories correspond to the 
ones defined into the software using the “Nuclide Category Editor”. The emission category is actually an 
advanced field to be used in future versions of this spectrometry software, and is not being used in the Basic 
version of the software. 

  A radiation emission can be grouped into several nuclide categories. However, this field is used 
in the advanced version of this software. Nuclide Categories are not used in the Basic Version of 
the bMCA software.  

The remaining fields can be changed as desired. Selecting “OK” will apply the changes; “Cancel” will discard 
them.  

WORKING IN MCS MODE  

The bMCA device can be set to acquire the spectrometry data in the so-called Multi-Channel Scaling (MCS) 
mode. In this mode the MCA is set to count only those events that match an specific region of the spectrum 
(Single Channel Analyzer) and the counts are accumulated for a period of time (Dwell time). After this time 
elapses, the total counts are registered into a channel number of the MCA. The operation is repeated for the 
next channel and so on. In such a way, the MCS spectrum becomes a function of recorded counts for an energy 
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window in function of time. This mode of acquisition has proven to be very useful in numerous applications, 
especially in the industry.  

The bMCA software not only allows you to set the MCA into this particular mode but it also implements 
unique, easy to use and fast methods for setting the MCS acquisition parameters. 

The MCA device can be simply set into MCS mode via the “Setting” dialog, as shown below. 

 

Figure 29 – Device settings for MCS acquisition mode. 

In this case, most hardware settings are commonly shared with PHA mode. However, the preset time now 
represents the Dwell time for each MSC step, and the LLD and ULD are used to set the lower and upper levels 
of the Single Channel Analyzer window, or SCA.  

Since the SCA boundaries are given in channel numbers, it becomes sometimes difficult to set the window for 
the exact region of interest from the whole PHA spectrum. To aid in this, the bMCA application includes several 
methods for interactive setting of the SCA in the MCS mode.  

If you click the “Setup” button, the dialog that appears next will give you access to these methods. 

The first and most straightforward way to use the MCS mode is to acquire a PHA spectrum with the bMCA and 
visualize the energy region of your interest. Then set an ROI interactively via the GUI of the software. 

Now bring the “Settings” dialog up and turn the bMCA device into MCS mode. To quickly set the SCA into the 
region you just selected during PHA acquisition, click the “Setup” button and the software will automatically 
import any defined ROIs from the PHA acquisition mode. Then you simply select the ROI by checking its 
associated checkbox, as shown below. 
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Figure 30 – Dialog for fast and easy methods for setting the MCS acquisition mode. 

Other methods to set the SCA in the MCS are: 

• Using an ROI definition stored into an ROI file. 
• Directly from a nuclide library. 

In both cases, if you keep the PHA spectrum displayed in the spectrum plot, you can preview the selection of 
the SCA window directly over the current energy spectrum, using the “Preview” option together with the 
FWHM coefficient. 

By selecting “Apply” the LLD and ULD settings of the MCS mode will be automatically set according to the 
selected region. 
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USING AN EXTERNAL APPLICATION FOR SPECTRUM PROCESSING 

The bMCA application can be configured to use an external application for further spectrum processing, and 
accessed at the click of a button. 

To enable that option, open the “Settings” dialog, select the “Misc” tab (Figure 31), and in the “Processing” 
group box check the “Enable external processing application” option. Then, set the following parameters: 

• In the “Data directory” text box enter the full path to the folder where the spectral files are to be 
saved. 

• In the “File name” box enter the name to be used for the spectral files. If no extension is specified, 
“.spe” is assumed. The special “%T” macro can be specified as a part of the filename, which expands 
to a timestamp string of the form “YYYYMMDD_hhmmss”. 

• In the “Program” text box enter the name of the application to be executed. If the application is not 
directly accessible via the system PATH variable, the full path to the program should be specified. 

• Finally, in the “Argument” box type the program arguments as they should be passed to the 
application in the command line. Here, the special macro “%D” can be used to specify the data 
directory defined earlier, and “%F” to specify the name of the file. Since “%D” already includes a 
trailing slash, the full path to the file can be constructed simply by using “%D%F”. 

 

Figure 31 - Preferences dialog: configuring an external processing application. 

Once the external processing application option is enabled, a “Process” button will appear at the rightmost 
location of the main toolbar (see Figure 32). When the “Process” button is clicked, the bMCA application will 
save the current spectrum to the specified data folder using the specified filename, and launch the external 
application passing the arguments as defined in the “Settings” dialog. 

Files are saved in full format (SPE), and will overwrite without warning any existing file with the same name. If 
the “%T” macro was specified as a part of the filename, the files will be saved under a different name each time 
and no overwriting will occur. 
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The bMCA application will not wait for the external application to finish processing and close, so work can 
continue concurrently (e.g. a new acquisition can be started). 
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SOFTWARE ELEMENTS 

This part of the manual briefly describes all the bMCA GUI components. For a more detailed description, please 
refer to previous “Basic Operations” chapter in this manual.  

MAIN MENU 

The bMCA software can be operated by a set of commands. These commands are organized in the standard 
menu bar that is shown at the top of the application window.  

The main menu contains the following items: 

File  

Connect Invoked the discover-device dialog for selecting a device to connect to 

Disconnect Disconnects from a bMCA device 

Open Opens a spectrum file 

Save spectrum only Saves the current spectral data into a file 

Save all Saves the current spectral data and acquisition parameters 

Print Generates and prints a report 

Exit Terminates program 

MCA 

Setup Invokes the MCA setup dialog 

Start Starts data acquisition 

Stop Stops data acquisition 

Clear Clears both data and time 

Edit 

Cut Cuts selection and paste it into the clipboard  

Copy Copy selection into the clipboard 

Paste Paste contents of the clipboard into selection 

ROIs 

Add Brings the ROI editor dialog 

Add from nuclide Brings the ROI editor from nuclide libraries  

Delete All Deletes all ROIs set into the current spectrum 

Save to file Saves current ROI definitions into an ROI file 
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Load from file Loads ROI definitions from stored files 

Calibrate Brings the calibration dialog for performing energy calibration  

Preferences Brings the preferences dialog for setting programs preferences 

View  

Toolbar Hides/shows the toolbar on the main window 

Status bar Hides/shows the status bar on the main window 

Info bar Hides/shows the info bar on the spectrum plot 

Zoom In Zooms into a spectrum region  

Zoom Out Returns to full spectrum view  

Dots Plots spectrum data using dots 

Lines Plots spectrum data using continuous lines 

Histograms Plots spectrum data using histograms 

Lin Use linear scale for the Y-axis in the spectrum plot 

Logs Use logarithmic scale for the Y-axis of the spectrum plot  

Sqrt Use square-root scale for the Y-axis of the spectrum plot 

Channels Sets the X-axis into channels  

Energy Sets the X-Axis into energy units (needs energy calibration) 

Scope Shows the digital oscilloscope window 

Tools 

Peak search Invokes the peak search dialog, allows to perform also energy calibration 

Nuclide editor Brings up the nuclide editor dialog for creating nuclide emission libraries  

Nuclide categories Brings up the dialog for creating and editing nuclide categories 

Help 

Topics Displays main help topics 

Device info Shows bMCA device-related information 

About Shows information about the software like version and release data 
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TOOLBAR 

The toolbar provides quick access to the most often used commands and operations (Figure 32). The toolbar 
control is readily accessible, since it is just on top of the spectrum plot area. The actions are represented as 
button icons, some of which serve to indicate the status of certain operations and communications with the 
MCA. 

 

 

 

Figure 32 - Main toolbar elements 

The toolbar can be shown or hidden by toggling the “Toolbar” option of the “View” menu. 

STATUS BAR 

The status bar is located at the bottom of the bMCA application window, and includes a set of information 
panels that inform the user in an efficient way about the status of several activities, like device connection and 
data acquisition. 

The information contained in the status bar panels is explained in the figure below. 

 

 

Figure 33 - Min status bar panels 

The status bar can be shown or hidden by toggling the “Status bar” option of the “View” menu accordingly. 

PREFERENCES 

The operations and look of the bMCA software can be customized in a simple way via the “Preferences” dialog. 
The different settings are organized into groups which are represented in the dialog as tabs. 

Program preference settings 

Here the parameters concerning the program operation are set (Figure 34).  

Linear scale for Spectrum Intensity  

Connect to a bMCA device Disconnect from bMCA device Shows the digital oscilloscope bMCA Settings and 
Acquisition setup 

Open a file 

Save spectrum 
into a file 

Produce a report and print 

Start data acquisition 

Stop data acquisition 

Clear data acquisition and 
elapsed timers 

Logarithmic scale for Spectrum Intensity  

Zoom in / Zoom out 

Device connection status Data acquisition status 

Device acquisition mode (PHA or MCS)  

Elapsed preset time (in seconds). Preset time 
marked with an *, when preset mode is on 
time. Dead time value is in parentheses.  

Launch an external 
processing application 

Preset mode and value 
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Figure 34 – Program preference settings. 

In the bMCA application, two coloring schemes for marking ROIs can be used: one that uses a single color, and 
a second that uses consecutively different colors from a set of eight. 

Checking the preference option “Use single ROI color scheme” will force the software to use the same color for 
any ROI defined. The specific color to be used can be specified with the color command button next to the 
option. Unselecting this option will make the software to use different colors for every ROI being defined. Each 
of the eight possible colors can be set individually with the help of the corresponding color selector button (as 
shown in Figure 34). Colors in this case are assigned to ROIs sequentially, wrapping back to the first color after 
the last one is used. 

The “Default nuclide library” field sets the nuclide library file to use whenever a nuclide-library-related 
operation is required by the program (e.g. for Energy Calibration). The nuclide library file must be compatible 
with the bMCA nuclide library format (*.nli). 

The option “Enable ROI follow up” is not used in this software version. 

When the option “Automatically open the last detector used next time the program is started” is checked, the 
bMCA application will remember the last detector connection used, and attempt to restore the connection 
when the program is run again. This is useful if you always use the same detector, as you will not have to go 
through the “Connect” dialog every time. If you want to go a step further and turn the High Voltage ON 
automatically as well, check the corresponding option.  

Display preference settings 

Here the settings that affect how the spectrum plot looks and feels are defined (Figure 35). 

Using the color selection buttons Back, Fore, Scale and Cursor the color of the background, foreground, scale 
and axes and spectrum cursors can be set accordingly. 

The option “Show grid” will enable grid lines on the spectrum plot display. 

The option “Filled plot” will make the spectrum plot to appear filled. Unchecking this option cause the 
spectrum to be drawn with a continuous line.  
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Figure 35 – Display preferences. 

“Default plot type” determines whether the graph is to be drawn with dots, lines, or as a histogram on program 
startup. 

“Default plot scale” sets the default type of scale for the Y-scale of the spectrum plot display. Choices are 
Linear, Square-root and Logarithmic. 

Misc. preferences 

This tab is divided in two groups, allowing to set the report generation preferences and to define an external 
processing application (Figure 36). 

 

Figure 36 - Misc preferences 

Inside the “Report sections” group box you can select which sections should be included in the report. The 
bMCA report can be printed using different color schemes, select the desired one from the corresponding pull-
down list. 
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In the “Processing” group box you can specify the details of an external processing application. 

Checking the “Enable external processing application” options will cause the “Process” button to appear on the 
toolbar of the main application. 

The “Data directory” specifies the folder where the spectral data files will be saved to, using the name 
indicated in the “File name” box. 

The name of the application to be executed is specified in the “Program” text box. If the application is not 
accessible via the system PATH variable, the full path to the program must be entered. 

The “Argument” box should contain the program arguments as they should be passed to the application. 
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APPENDIX A: INSTALLATION OF BMCA DRIVERS UNDER WINDOWS 8 

The installation of bMCA device drivers and software might fail under Windows 8 due to the new restricted 
policy for installing third party drivers (*.INF) that do not contain digital signature.  

To proceed with such driver installation you must disable the Windows 8 driver enforcement option. The 
following steps show you how to do this: 

Using the PC Settings, press SHIFT key while clicking at the Restart menu option from POWER 

 

 

The following screen should appear: 
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Choose the option “Troubleshoot” 

From the Troubleshoot menu choose “Advanced options”, as shown below: 

 

And from Advanced options select “Startup settings”: 
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From “Startup Settings” screen choose Restart : 

 

On next booting screen choose option 7, “Disable driver signature enforcement”, by pressing “F7” key from the 
keyboard: 
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After this the driver and software installation should progress as expected. 
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